April 2013

Optimizing Stress Concentrations in HPP Lever Guide Using Finite Element Analysis

Jacob A. Baril
Worcester Polytechnic Institute

Nicholas Glen Hayes
Worcester Polytechnic Institute

Sowmit Raj Barua
Worcester Polytechnic Institute

Follow this and additional works at: https://digitalcommons.wpi.edu/mqp-all

Repository Citation

This Unrestricted is brought to you for free and open access by the Major Qualifying Projects at Digital WPI. It has been accepted for inclusion in Major Qualifying Projects (All Years) by an authorized administrator of Digital WPI. For more information, please contact digitalwpi@wpi.edu.
Optimizing Stress Concentrations in HPP Lever Guide

Using Finite Element Analysis

A Major Qualifying Project Report
Submitted to the Faculty of the
Worcester Polytechnic Institute
In partial fulfillment of the requirements for the
Degree of Bachelor of Science in Mechanical Engineering

By
Jacob Baril
Sowmit Barua
Nick Hayes

Project Advisor:
Professor Zhikun Hou, ME

Date: 4/24/2013
Acknowledgements

We would like to thank Professor Zhikun Hou for his time and guidance through the completion of this project. We would also like to thank Dr. Adriana Hera and Ms. Yang Song for their aid with ANSYS APDL and Workbench software.
Abstract

High pressure processing (HPP) is one of the most effective and efficient preservation methods in the food industry due to its ability to prepare fresh, hygienic food. The goal of this project is to reduce the stress concentration that arises in the contact area between the lever and lever guide in a particular HPP vessel. Various finite element analyses were performed in order to develop an effective solution that will decrease the stress concentration in this area.
Executive Summary

This report provides a through finite element analysis using ANSYS software package to reduce the stress concentration that arises in the contact area between the lever and lever guide in a HPP vessel. HPP or High pressure processing is one of the newest ways to process food without directly heating up the food content.

HPP is becoming rapidly popular in the food and restaurant industry because of its unique ability to kill bacteria without compromising the freshness of the food. However ultra-high pressure processing is a costly matter and the equipment for it is expensive and not widely manufactured. Because of this, it is important to extend the life of this machinery as long as possible. We analyzed a simple cylindrical vessel used in HPP, and attempted to reduce the stress concentrations that occur in it, which should lead to the part having a longer life before failure occurs.

Due to the structure of the vessel a high stress concentration happens at two critical regions: The area in the vicinity of the fillets; and the area around the corner where the lever and the lever guide come in contact. We used ANSYS APDL and ANSYS Workbench to determine the maximum principal stress and Von Mises stress that arise in the two critical areas. Then we introduced stress relief grooves of various radii and chamfer lengths in order to find the optimal geometry that most reduced the maximum principal and Von Mises stresses of the system.

Our results show the overall stress reduced by 51% at the optimum radius and chamfer length combination of 3.5 mm and 2 mm. The project found that with increasing radii, the maximum principal stress decreased but the Von Mises stress increased when the lever was overhanging the lever guide by more than 4mm. Observing the behavior of the stress
concentration for different geometries provides insight as to where this stress concentration comes from, and how it can be prevented.
# Table of Contents

Acknowledgements ........................................................................................................... ii

Abstract ............................................................................................................................ iii

Executive Summary ......................................................................................................... iv

List of Figures ................................................................................................................. viii

List of Tables .................................................................................................................. ix

1. Introduction ................................................................................................................ 2
   1.1 High pressure processing (HPP) ............................................................................ 2
   1.2 Objectives ............................................................................................................. 6

2. Finite element method (FEM) background .................................................................. 8
   2.1 History of the Finite Element Method .................................................................. 8
   2.2 Approaching a problem with FEM ....................................................................... 9
   2.3 Practical application of the ANSYS software package ....................................... 10
      2.3.1 Model 1: Cross shape with fillet .................................................................. 10
      2.3.2 Model 2: A modified Kirsch solution for a cube with central spherical hole .... 13
      2.3.3 Model 3: Stress concentration regions for scanning probe microscopy .......... 14
      2.3.4 Model 4: FEM approach to predict the stress concentration factors in cold formed corners .... 15

3. Methods and Results .................................................................................................. 19
   3.1 Application of FEM to HPP vessel ...................................................................... 19
      3.1.1 Method 1 ...................................................................................................... 20
      3.1.2 Method 2 ...................................................................................................... 23
      3.1.3 Discussion ................................................................................................. 25
   3.2 Results .................................................................................................................. 25
      3.2.1 Examination of the optimal stress relief groove shape using 2D analysis ...... 25
      3.2.2 Von Mises stress and maximum principal stress distribution (Workbench) .... 26
      3.2.3 Von Mises stress and maximum principal stress distribution (APDL) ........... 35
   3.3 Discussion ............................................................................................................ 41
      3.3.1 Challenges and limitations ........................................................................... 41
      3.3.2 Effects of the mesh ...................................................................................... 42

4. Conclusion .................................................................................................................. 46

Appendices ...................................................................................................................... 48

Appendix 1: APDL codes ................................................................................................. 48
List of Figures

Figure 1: High pressure processing procedure. (Ohio State University, 2005) ................................................. 3
Figure 2: Pin-arm sealed pressure vessel structure for food processing. (Otsuka, 2012) ........................................ 5
Figure 3: Stress concentration factor vs. r/d. (Hartman, 1951) ........................................................................... 11
Figure 4: Contour plot for bar in bending ........................................................................................................... 12
Figure 5: Round and straight cornered steel tube (Anis, 2012) ......................................................................... 16
Figure 6: Stress concentration in cold-formed corners experiment ........................................................................ 17
Figure 7: Lever and lever guide mesh .............................................................................................................. 20
Figure 8: Von Mises stresses for lever and lever guide ....................................................................................... 21
Figure 9: Mesh for the stress relief groove model ............................................................................................... 22
Figure 10: Von Mises stress .................................................................................................................................. 22
Figure 11: Model with mesh for Method 2 ........................................................................................................ 23
Figure 12: Von Mises stress for Method 2 ........................................................................................................ 24
Figure 13: Von-Mises stress distributions at varying radii ................................................................................. 27
Figure 14: Max Principal stress distributions at varying radii ........................................................................... 28
Figure 15: Contour plot of the maximum principal stress .................................................................................. 30
Figure 16: Contour plot of the Von Mises stress at Region A ............................................................................. 31
Figure 17: Contour plot of Von Mises stress at Region B .................................................................................... 31
Figure 18: Maximum principal stress .............................................................................................................. 32
Figure 19: Von Mises stress at Region A ........................................................................................................... 32
Figure 20: Von Mises stress at Region B ........................................................................................................... 33
Figure 21: No stress relief groove, chamfer length = 4mm .............................................................................. 37
Figure 22: Radius = 1mm, chamfer length = 4mm ............................................................................................. 38
Figure 23: Radius = 2mm, chamfer length = 4mm ............................................................................................. 39
Figure 24: Radius = 3mm, chamfer length = 4mm ............................................................................................ 40
Figure 25: Example of a rough mesh ................................................................................................................ 43
Figure 26: Example of a smooth mesh .............................................................................................................. 43
Figure 27: Von Mises stress generated from rough mesh ................................................................................... 44
Figure 28: Von Mises stress generated from smooth mesh ............................................................................... 44
List of Tables

Table 1: Von Mises and max principal stress at Regions A and B ......................................................... 29
Table 2: Von Mises and max principle stress distribution .......................................................................... 35
1. Introduction

Many of the processed foods that we buy today are often heat treated to kill bacteria or any other type of food borne pathogens or yeast. Although heat treatment is necessary for the safety of our foods it often diminishes the food quality. High Pressure Processing (HPP) is an alternative to heating our foods. It is a method of food processing where food is subjected to elevated pressures (up to 87,000 pounds per square inch or approximately 6,000 atmospheres), with or without the addition of heat, to achieve microbial inactivation or to alter the food attributes in order to achieve consumer-desired qualities. (Ramaswamy, Balasubramaniam, & Kaletun, 2003) HPP maintains the food freshness while retaining the food quality and extending microbiological shelf life. Since HPP eliminates thermal degradation it results in food with better taste, appearance, and nutrition.

1.1 High pressure processing (HPP)

High pressure processing improves food safety by destroying the bacteria that cause food borne illness and spoilage, as well as parasites that cause diseases. In a typical process, pre-packaged raw product is loaded inside a pressure chamber and subjected to very high pressures for a specific length of time. This whole process usually takes 10 minutes or less. Pressures used are almost ten times greater than in the deepest oceans on earth. (Ramaswamy, Balasubramaniam, & Kaletun, 2003) High-pressure processing allows the food to maintain its freshness since the small molecules that are responsible for flavor and nutrition are not altered by pressure.

The magnitude of the chemical reaction among food molecules is increased due to the high pressure the food experiences. On the other hand, pressure slows down the chemical
reactions that result in increased volume, also known as positive activation volume. Since high pressure process is volume independent, the pressure is instantaneous and uniform throughout the pressure vessel. In a HPP procedure, pressure leads to increased ionization due to the compact water molecule arrangements around electric charges. This process is known as electrostriction. There is also very small energy input required in HPP as compared to comparable thermal processes.

Figure 1 shows a simplified HPP vessel with a food product inside. As pressure is applied in the vessel, the pressure is transmitted uniformly to the food product. This means that the shape of the food product is preserved, provided it does not have any air pockets inside of it.

![Figure 1: High pressure processing procedure. (Ohio State University, 2005)](image)

In a typical HPP process, the product is packaged in flexible containers (usually a pouch or plastic bottle) and is loaded into a high pressure chamber similar to the setup shown in Figures 1 and 2. This high pressure chamber is filled with a pressure-transmitting (hydraulic) fluid. The
hydraulic fluid (normally water) in the chamber is then pressurized with a pump. This pressure is transmitted through the package into the food itself. Pressure is applied on the package for a specific amount of time, usually 3 to 5 minutes. The processed product is then removed and stored/distributed in the conventional manner. Since the pressure is transmitted uniformly, food retains its shape, even at extreme pressures. Due to the minimum heat needed, the taste of the food is retained without compromising microbial safety.

Although HPP is a very efficient and effective food processing method, it cannot be applied to all types of foods. HPP can be used to process both liquid and solid foods (Ramaswamy, Balasubramaniam, & Kaletun, 2003). Research shows foods with a high acid content are particularly good candidates for HPP technology. At the moment, HPP is being used in the United States, Europe, and Japan on a select variety of high-value foods either to extend shelf life or to improve food safety. Some products that are commercially produced using HPP are cooked ready-to-eat meats, avocado products (guacamole), tomato salsa, applesauce, orange juice, and oysters. Technology is not ready so that HPP can be used to produce shelf ready low acid products such as vegetables and milk. These products need added heat to destroy the spores that they contain making HPP ineffective. Also, foods that have air pockets cannot be processed by using HPP. These types of food materials would be crushed due to the high pressure.

High pressure procedure is generally used to retain the taste, texture and nutrition of foods. Since HPP has very little effect on low molecular weight compounds such as flavor compounds, vitamins, and pigments compared to thermal processes (Ramaswamy, Balasubramaniam, & Kaletun, 2003); the quality of HPP food is almost similar to fresh food products.
High pressure equipment is a mature and efficient technology as most high pressured vessels are manufactured under American Society of Mechanical Engineers (ASME) boiler and pressure vessel codes. A commercial scale, high-pressure vessel costs between $500,000 to $2.5 million dollars depending upon equipment capacity and extent of automation (Ramaswamy, Balasubramaniam, & Kaletun, 2003). As a new processing technology with a limited market, pressure-processed products may cost 3 to 10 cents per pound more to produce than thermally processed products. With two 215-liter HPP units operating under typical food processing conditions, an output of approximately 20 million pounds per year is achievable. High output is accomplished by using multiple pressure vessels. Factory production rates beyond 40 million pounds per year are now in operation. As demand for HPP equipment grows, capital cost and operating cost will continue to decrease. Consumers benefit from the increased shelf-life, quality, and availability of value-added products and new types of foods that are impossible to make using thermal processing methods (Ohio State University, 2005).

![Pin-arm sealed pressure vessel structure for food processing. (Otsuka, 2012)](image)

*Figure 2: Pin-arm sealed pressure vessel structure for food processing. (Otsuka, 2012)*
Figure 2 shows the lever and lever guide that our project is analyzing. This is a cross-sectional view from the side of the part. If viewed from above, the grey part is a cylinder, into which the food product is placed. Then, it is sealed with the green cover, which is fitted with a gasket to ensure a snug fit. The brown squares represent the horseshoe-shaped lever, which enters the part from the side. When the pressure is applied in the vessel, the upward component of that pressure acts on the cover, which is held in place by the lever. The corners of the lever guide, where it meets the lever, are circled in red, because this is where the high stress concentrations occur. It is these stress concentrations which this project hopes to reduce.

1.2 Objectives

Experiments have shown that there are various benefits at ultra-high pressure, usually higher than 100 MPa. However ultra-high pressure processing is a costly matter and a small amount of this type of equipment is manufactured. We used the conventional seal mechanism for ultra-high pressure equipment, for the cover we used a push-type structure which is similar to a press. Using this method we acquire a simple structure of the vessel and the lid. Despite being a simple structure this can withstand ultra-high pressure.

In this structure a concentration of stress happens at the vicinity of the fillets that surrounds the vessel. Since this area contains the highest stress concentration the goal of this project is to reduce the stress in that area. Various stress relief grooves are introduced in the fillet area of high stress concentration. Using Finite Element Analysis (FEA) Software we designed and analyzed the stress concentration compared to the base stress concentration without any stress relief groove.

The purpose of this project is to replicate and improve upon the results put forth in “Design Optimization of Stress Relief Grooves in Lever Guide of Pressure Vessel for Food
Processing,” published in 2012 in the Open Journal of Safety Science and Technology by Yuichi, Baron, and Mutoh. This project focuses on using the finite element analysis method in a program called Mechanical APDL (ANSYS Parametric Design Language), produced by ANSYS, Inc. This is popular software for creating mechanical and structural models.
2. Finite element method (FEM) background

2.1 History of the Finite Element Method

The Finite Element Method (FEM), also known as Finite Element Analysis (FEA) is an advanced modeling system that can very accurately replicate stresses in many sorts of subjects. Originally developed in 1943 by Richard Courant, it involves creating a mesh or lattice across the entirety of a part, creating many small elements. (Widas, 1997)

FEM was not popular when it was first developed – The sheer amount of calculations it required made it highly impractical. Known as the “Direct Stiffness Method,” its early incarnations were used by the aircraft industry when it became apparent that a traditional beam analysis was not sufficient for analyzing aircraft wings. (Clough, Early History of the Finite Element Method from the View Point of a Pioneer, 2004) Progress was made in advancing the mathematical model in 1953 by Boeing engineers Jon Turner and R.W. Clough, who pioneered the use of creating a matrix of 2D elements. (Turner, Clough, Martin, & Topp, 1956) This research focused on analyzing vibrations through a beam, but Clough realized it could also be applied to stress analysis, and published his findings in a 1960 paper, “The finite element method in plane stress analysis” (Clough, 1960) in which he coined the term ‘finite element method.’

Clough’s findings received middling attention at the time, (Clough, Early History of the Finite Element Method from the View Point of a Pioneer, 2004) but by the early 1970’s, computing technology had advanced to a point that made engineers consider revisiting FEA. (Widas, 1997) Now that computers could handle the complicated and time-consuming calculations, it was a much more feasible process than the early days of FEA, in which these calculations would have been done tediously by hand. Computer technology has boomed since the 1970’s, and in the modern age, computers are powerful enough that even a standard home PC
can run FEA software. Now, FEM is a widespread and highly regarded method for analysis in many engineering disciplines.

2.2 Approaching a problem with FEM

The Finite Element Method (FEM) is based on the direct stiffness approach, or displacement approach. For a structural analysis, the structure gets discretized naturally and members between two joints are treated as an element. In this way, FEM discretizes the original continuous system as an assembly of discrete elements connecting at nodes. This discretization is also known as meshing. The mesh is usually not uniform, and a finer mesh is often used in the area where the displacement gradient is larger. This is the preprocessing component of the FEM analysis.

Based on local coordinate system, the displacement within each element is interpolated using nodal displacements. This is known as Displacement Interpolation. Then the Finite Element equation is solved for the displacement at the nodes which generates a stiffness matrix (k) for each element. After that displacement, constraints are imposed. (If they aren’t constrained, there will be rigid body movement, which defies the purpose of static analysis.) Then, the elements are connected and loads are assembled into load vectors. The user imposes support conditions and displacement equations are solved. This is part of computational process. Finally, in the post-process, the user acquires results and is presented with options on how to view and interpret the solution.
2.3 Practical application of the ANSYS software package

After the literature review, the next phase of the project was for the group members to familiarize themselves with ANSYS software in preparation for analyzing the final model. These models below were independently researched and then replicated as hands-on practice.

2.3.1 Model 1: Cross shape with fillet

Westinghouse Research Laboratories investigated the relationship between fillets of varying geometry and the stress concentration factor for flat bars in bending. (Hartman & Leven, 1951) They concluded that the stress concentration factor decreased as ratio between radius of the fillet and the width of the narrow section increased. An example of their results is shown below in Figure 3.
Figure 3: Stress concentration factor vs. r/d. (Hartman, 1951)
Their definition of the stress concentration factor is the ratio of the maximum stress at the fillet over the nominal stress. For the case of pure bending, the nominal stress at the fillet is defined as the ratio of the moment on the end of the bar to the moment of inertia of the bar.

The results for the case of bars in pure bending were recreated in ANSYS APDL. The bar was modeled in SolidWorks and imported into ANSYS using a Solid 273 element type. The bar is constrained in the Y direction on the orange line in Figure 4 and constrained in the X direction on the blue line. A moment of 350lbs was applied in the counter clockwise direction on the purple line. For a fillet radius of 0.157 inches and a narrow section width of 2 inches the contour plot of the Von Mises Stresses and stress concentration factor calculations are shown below in Figure 4:

![Contour plot for bar in bending](image)

Figure 4: Contour plot for bar in bending

By analyzing the relationship between varying geometry and the resulting Von Mises stresses, reduction in the stress concentration factor is observed. The stress concentration factor
is defined as the maximum stress at the fillet divided by nominal stress the bar experiences. The nominal stress for a beam in this loading configuration is six times the moment force divided by the moment of inertia. For a maximum stress of 273.87 psi and a nominal stress of 131.25 psi, the stress concentration factor is 2.09. This is helpful to calculate when developing stress relieve grooves, when the stress concentration factor needs to be minimized. As seen in the results above, the larger the radius, the lower the stress concentration factor. This information will be useful when creating a stress relieve groove for the pressure vessel.

2.3.2 Model 2: A modified Kirsch solution for a cube with central spherical hole

A research paper by L.H. He and Z.R. Li, published in 2005, proposed a new analytical method for determining stress concentrations caused by small holes. The Kirsch solution is a well-known formula in stress analysis, in which the stress concentrations are analyzed in a flat rectangular plate with a circular hole in the center. This research paper proposed an expanded version of the Kirsch solution for a three-dimensional model, that is, a cubical block with a spherical hole in the center. This was useful for the project group because the calculated results could easily be compared to results obtained in ANSYS to determine whether or not the ANSYS results were reliable.

The model proposed is a cube with a spherical hole at the center of the part. For simplicity, the part was modeled with cube side lengths of 100mm and hole radius of 1mm. A pressure of 10 N/m was applied to one side of the cube.

The simplest way to confirm the results would be to compare the values of $\sigma_{00}$, where $R/r=1$. In other words, the stress is calculated in the direction of the applied pressure, at a point
on the edge of the spherical hole. This value could be calculated by the modified Kirsch solution presented in the paper. By calculation:

\[ \sigma_{\theta\theta} = 19.05 \, N/m^2 \]

By ANSYS Workbench:

\[ \sigma_{\theta\theta} = 33.87 \, N/m^2 \]

This is disappointing, because these values are not close enough to each other. They are within the same order of magnitude, but seeing as they differ by almost 15N/m², that is a rather large discrepancy. This highlighted one of the challenges the group faced. Modeling in three dimensions in ANSYS is significantly more difficult than modeling in two dimensions. In comparison, a traditional Kirsch solution was calculated by the group and modeled in ANSYS and the results matched quite well.

2.3.3 Model 3: Stress concentration regions for scanning probe microscopy

One of the background researches that we did was Finite Element Analysis of Piezoresistive Cantilever with Stress Concentration Holes. (Bashir, Gupta, Neudeck, McElfresh, & Gomez, 2000) As we took on different materials one of our group members decided to work on this topic as Cantilever sensors are based on relatively well known and simple transduction principle. The paper that he focused on provided a method of increasing device surface stress through introducing stress concentration holes of paddle cantilevers for small force sensing using finite element analysis (FEA) software, ANSYS. Specifically, the piezoresistive sensitivity enhancement due to the use of novel stress concentration holes, to localize stresses, is examined.
Four basic designs were studied, i.e. a paddle type cantilevers with different holes patterns. The placement of the holes was found to be critical and optimal placement results in improvements of piezoresistive displacement and force sensitivity, respectively. We started off with simple and paddle cantilever sensors which were modeled using the static equations of mechanics. Using ANSYS we tried to reproduce the results but after couple of tries we realized how we didn’t have the appropriate knowledge to understand the real theory behind the experiment or the knowledge that the research group used by manipulating ANSYS in order to produce the result that they acquired.

2.3.4 Model 4: FEM approach to predict the stress concentration factors in cold formed corners

Another background research that we did during the preliminary process of the project was Finite Element Analysis of Stress Concentration Factors in cold formed corners (Anis, Bjork, Heinilla, 2012). Cold formed rectangular steel hollow sections are widely used in load-carrying structures because of their good load transfer behavior. Notches in cold formed corners require special attention as their presence reduces decreases the overall resistance to fatigue failure. Usually the corners in cold formed rectangular hollow sections are the areas of high stress concentration. Due to this phenomenon the group looked at stress concentration in cold formed steel hollow tube due to corner radii and notches present inside the cold formed members. The research was done by performing two-dimensional linear static analysis with various notch shapes and sizes. The tubes that were modeled are shown in Figure 5 below:
In order to investigate the notch effect in Cold formed rectangular steel hollow sections (CFRHS) we modeled two tubes with round corners and then with tangential notch. We used ANSYS APDL with 2D plane element and force was applied on the left bottom corner of the tube which was placed at an angle of 53.13°. Due to the applied force, the tube was deformed and notch stress ($\sigma_Y$) was obtained from post-processor in ANSYS APDL. The loaded and deformed structural tube is shown in Figure 6 below:
From this finite element analysis we obtained the notch stress that developed in the cold formed tube. This stress is used in the following equation to find the stress concentration factor:

\[
K = \frac{\sigma_{\text{notch}}}{\sigma_{\text{nominal}}}
\]

where \(\sigma_{\text{notch}}\) is the notch stress, \(\sigma_{\text{nominal}}\) is the nominal stress, and \(K\) is the elastic stress concentration factor. We varied the geometry with various notch sizes and observed the notch stress based on that. We compared our results with the published results. Most of our results were within \(\pm 5\%\) accuracy of the published results which helped us realize that our implementation of the procedure was correct. This was also essential in our analysis of the stress relief groove. We realized that by changing the chamfer length we can drastically reduce the

**Figure 6: Stress concentration in cold-formed corners experiment**
stress concentration factor in the HPP lever. This also helped us gain confidence in our knowledge of ANSYS software.
3. Methods and Results

A paper on the design optimization of stress relief groove in a lever guide of a pressure vessel was published in the Open Journal of Safety Science and Technology. The stress relieve groove consists of two parameters, a fillet on the corner of the lever guide, and an overhang length. The results concluded that a radius of 3 millimeters and an overhang length of greater than 0 provide Von Mises stresses below the fatigue strength of the material. Stress relieve grooves with radii of 1, 2 and 3 millimeters and an overhang length of 4, 2, 0, and -2 millimeters were analyzed for a pressure of 200 MPa the FEM program MARC/MENTAT. (Otsuka, Bin Baron, & Mutoh, 2012)

Our MQP consisted of replicating, performing, and reviewing similar FEM Analyses. Our main purpose was to gain a solid knowledge of ANSYS and apply it to observe the behavior of stress concentration. All three of us had a limited amount of experience ANSYS from the ME4512 course (Finite Element Analysis), which featured APDL as part of the laboratory component. From there, further investigations were conducted for practice, as documented in Section 2.3. The next step was to replicate the results from the published HPP vessel analysis. Once that was completed, we modified the HPP model, obtained results, and attempted to further refine and improve upon those results.

3.1 Application of FEM to HPP vessel

Now that we were reasonably confident in our abilities to obtain accurate results in ANSYS, it was time to replicate the published results. We pursued different methods in order to see which yielded the best results.
3.1.1 Method 1

The results from the paper were recreated in ANSYS APDL. A solid model was created in SolidWorks and imported into ANSYS as a plane 183 element type. The element shape is quadrilateral and is refined at the fillet and the interface of lever guide and the lever. Note the refinement at the sides and corners of the lever guide. The mesh is shown below in Figure 7:

![Figure 7: Lever and lever guide mesh](image)

A contact element was created between the lever and the lever guide, with the lever guide being the target and the lever being the contact area. This was to establish the boundary conditions of the model, as well as the coefficient of friction. Since both the lever and the lever guide are two separate pieces and move independently, a contact element is necessary to establish the relationship between how each piece moved in relation to the other. The Lagrangian contact algorithm was used to define how the contact element behaved. As seen in
Figure 7, the model is constrained in the Y direction on the orange lines and constrained in the X direction on the blue line. A pressure of 200MPa was applied in the positive Y direction on the purple line. Figure 8 represents the contour plot of the Von Mises stresses.

![Contour plot of Von Mises stresses](image)

**Figure 8: Von Mises stresses for lever and lever guide**

A maximum stress of 1500 MPa was found at the contact between the lever and the lever guide as compared to 1742MPa found in the paper. The mesh and boundary conditions for the model used to analyze this model can be seen in Figure 9. With the same loading and boundary conditions as in the previous model, a spline shaped stress relief groove was analyzed in ANSYS. As seen in Figure 10, the contour plot of the Von Mises Stresses shows that the maximum stress is actually higher than the original model, with a maximum value of 1550 MPa. This is due to the behavior of the lever as it deforms into the lever guide.
Figure 9: Mesh for the stress relief groove model

Figure 10: Von Mises stress
A stress relieve groove designed previously for the same HPP model was more effective than the one created using a spline. This particular stress relieve groove decreased the Von Mises stresses to 526 MPa as opposed to our team’s 1550 MPa shown above. Further investigation of other geometry types will be carried out decrease the Von Mises stresses even more.

3.1.2 Method 2

In this method, the part was designed in SolidWorks and then exported as an IGES file. It was then imported into ANSYS APDL for modeling. The part was made with a groove radius of 1mm. The lever was modeled as a rigid body, as it had been in the original research paper. Figure 11 shows the model with mesh. Note that a tri-node element is being used instead of the default quad-node element. A triangular node is more appropriate for this part because there is a smooth curve around the stress relief groove.

Figure 11: Model with mesh for Method 2
A 200MPa pressure was applied in the upwards direction on the section of the lever guide, where the lever would contact it. The resulting Von Mises Stress is displayed in Figure 12.

![Figure 12: Von Mises stress for Method 2](image)

There was a maximum Von Mises stress of 647MPa. However, the behavior was not what was expected. In the original research paper, a stress concentration had been observed at the corner where the lever began contact with the lever guide. This was absent in this model. Additionally, the deformation that occurs is inconsistent with what should occur in this problem. This was due to modeling the lever as a rigid body instead of including it in the model as a separate part in the model.
3.1.3 Discussion

From pursuing both these methods, it became apparent that using a contact element was a crucial part of the analysis. Simply modeling the lever as an equivalent pressure did not produce accurate results. Therefore, the results described in the following section were all based on a model that included a contact element between the lever and lever guide.

3.2 Results

3.2.1 Examination of the optimal stress relief groove shape using 2D analysis

We started off with a 2D analysis of the stress relief groove. In order to find an optimal shape for the stress relief groove, a simplified 2D model of the cylindrical vessel was developed using ANSYS Workbench software and analysis was carried out using this model. We carried out the analysis of the pressure vessel using one of the commonly used FEA program ANSYS Workbench. The original model of the vessel was analyzed using 2D elasticity, a target and a contact point stress body was used.

Based on the background research, the FEA model was cut in half longitudinally to obtain a cross-section and that model was used as the base model. From the base model few other models were created with varying radii and chamfer lengths. The chamfer length is the length that represents the lever guide and lies right underneath the radius/fillet of our model. Our base model was without the groove and the other models were with semicircular grooves of radii 1, 2, 3, and 4 mm, respectively. These radii were analyzed with chamfer lengths of 1, 2, 3, and 4 mm as well. With various radii and varying chamfer lengths, we decided to look at the linear effect of those on the overall stress of the lever. The friction between the lever guide and the
lever was defined with a value of 0.2. To simulate a high pressure during the operation of the equipment we applied an upward pressure of 200MPa.

3.2.2 Von Mises stress and maximum principal stress distribution (Workbench)

From Figure 13 and Figure 14, we can see the Von Mises stress distribution and maximum principal stress distribution in the vicinity of the R area for a conventional cylindrical model. Included are a model without a groove and models with groove radii of 1, 2, 3, and 4 mm. The chamfer length is 4mm in all cases. From Table 1 we can see the stress concentration in two main areas: A, which is the region around the stress relief groove; and B, which is the region where the lever contacts the lever guide.
Figure 13: Von-Mises stress distributions at varying radii
Figure 14: Max Principal stress distributions at varying radii

- R = 1mm, CL=4mm
- R = 2mm, CL=4mm
- R = 3mm, CL=4mm
- R = 4mm, CL=4mm
From Figure 14, the maximum stress that occurs at the contact region of the lever and the lever guide reduces as we introduce stress relief groove. Models with stress relief groove have lower stress distribution compared to the base model without groove. The degree of reduction of maximum principal stresses becomes higher as the groove radius increases from 1mm to 4 mm.

**Table 1: Von Mises and max principal stress at Regions A and B**

<table>
<thead>
<tr>
<th>Radius</th>
<th>Chamfer Length</th>
<th>Von Mises Stress (MPa)</th>
<th>Max Principal Stress (MPa)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Region A</td>
<td>Region B</td>
</tr>
<tr>
<td>1mm</td>
<td>1mm</td>
<td>1314</td>
<td>1095</td>
</tr>
<tr>
<td></td>
<td>2mm</td>
<td>1251</td>
<td>1043</td>
</tr>
<tr>
<td></td>
<td>3mm</td>
<td>1240</td>
<td>963</td>
</tr>
<tr>
<td></td>
<td>4mm</td>
<td>898</td>
<td>1097</td>
</tr>
<tr>
<td>1.5mm</td>
<td>1mm</td>
<td>1165</td>
<td>1036</td>
</tr>
<tr>
<td></td>
<td>2mm</td>
<td>1057</td>
<td>1189</td>
</tr>
<tr>
<td></td>
<td>3mm</td>
<td>967</td>
<td>1087</td>
</tr>
<tr>
<td></td>
<td>4mm</td>
<td>956</td>
<td>1147</td>
</tr>
<tr>
<td>2mm</td>
<td>1mm</td>
<td>985</td>
<td>1116</td>
</tr>
<tr>
<td></td>
<td>2mm</td>
<td>901</td>
<td>957</td>
</tr>
<tr>
<td></td>
<td>3mm</td>
<td>820</td>
<td>965</td>
</tr>
<tr>
<td></td>
<td>4mm</td>
<td>817</td>
<td>992</td>
</tr>
<tr>
<td>2.5mm</td>
<td>1mm</td>
<td>861</td>
<td>1107</td>
</tr>
<tr>
<td></td>
<td>2mm</td>
<td>786</td>
<td>1011</td>
</tr>
<tr>
<td></td>
<td>3mm</td>
<td>776</td>
<td>931</td>
</tr>
<tr>
<td></td>
<td>4mm</td>
<td>771</td>
<td>991</td>
</tr>
<tr>
<td>3mm</td>
<td>1mm</td>
<td>922</td>
<td>1793</td>
</tr>
<tr>
<td></td>
<td>2mm</td>
<td>828</td>
<td>1490</td>
</tr>
<tr>
<td></td>
<td>3mm</td>
<td>825</td>
<td>1061</td>
</tr>
<tr>
<td></td>
<td>4mm</td>
<td>664</td>
<td>844</td>
</tr>
<tr>
<td>3.5mm</td>
<td>1mm</td>
<td>770</td>
<td>1017</td>
</tr>
<tr>
<td></td>
<td>2mm</td>
<td>735</td>
<td>476</td>
</tr>
<tr>
<td></td>
<td>3mm</td>
<td>693</td>
<td>1037</td>
</tr>
<tr>
<td></td>
<td>4mm</td>
<td>617</td>
<td>855</td>
</tr>
<tr>
<td>4mm</td>
<td>1mm</td>
<td>619</td>
<td>560</td>
</tr>
<tr>
<td></td>
<td>2mm</td>
<td>646</td>
<td>1230</td>
</tr>
<tr>
<td></td>
<td>3mm</td>
<td>616</td>
<td>1730</td>
</tr>
<tr>
<td></td>
<td>4mm</td>
<td>583</td>
<td>914</td>
</tr>
</tbody>
</table>
The contour plots below show the maximum principal stress in the entire part, and the Von Mises stresses at regions A and B. Radii are plotted on the X-axis, chamfer lengths are plotted on the Y-axis, and the overall stress distribution is plotted in the Z-axis. The plots show the overall stress distributions that are presented in the table above. From the contour plots, we can see that the overall stress distribution for the Maximum Principal Stress decreases as the radii and chamfer lengths increase. The contour plots in Figure 15 through 17 show the maximum principal and Von Mises stress distribution:

![Maximum Principle Stress](image)

**Figure 15: Contour plot of the maximum principal stress**
For the sake of clarity, the same data is presented again in another format in Figure 18 through 20. As seen in Figure 18, as the chamfer length and radius increase, the max principal
stress decreases steadily. However, from Figure 19 and Figure 20, the Von Mises stresses at the critical points are not so predictable.

**Figure 18: Maximum principal stress**

**Figure 19: Von Mises stress at Region A**
If we observe the Von Mises stress and max principal stress distribution of the base model (with no stress relief groove) and the model with a 4mm radius, the model with a stress relief groove has a stress reduction of about 45% from the model without any stress relief groove, despite both of the models having the same chamfer length of 4mm. As we increase the radius of the stress relief groove, the overall maximum principal stress of the lever decreases.

However, we have a different stress distribution when it comes to the critical regions. The overall stress distribution for Region A decreases as the radius decreases and chamfer length increases. There is an increase of stress when the radius is 4mm with a chamfer length of 2mm but stress decreases as the radii increase to 3mm and 4 mm. We are not sure why the spike in stress is at that chamfer length, but it could be due to how the lever guide deforms into the lever at that chamfer length. Critical Region B has high stress distribution at low radii. That high stress arises due to the overhang length that the lever guide has at low radii but high chamfer length.
Due to that reason, we see that as we increase radii and the chamfer length, the overall stress decreases. With an increase in chamfer length and radii the overhang length of the lever guide decreases which means the lever guide deforms less into the lever which results into the reduced stress distribution that we see on the structure. This change in stress assures that the change in contacting area between the lever guide and the lever can affect the stress concentration conditions but overall the stress reduces as the radii increase and the chamfer lengths increase.

This overall stress reduction can also be seen as we find and compare the stress concentration of various radii and chamfer length combination to the stress concentration of the base model. Theoretically, we can find stress concentration $K$, using the following formula,

$$K = \frac{\sigma_{\text{max}}}{\sigma_{\text{nominal}}}$$

where $\sigma_{\text{max}}$ is the maximum stress and $\sigma_{\text{nominal}}$ is the nominal stress. Here we used nominal stress instead of average stress because nominal stress is calculated based on the net cross section of a model without taking into account the effect of geometric discontinuities such as holes, grooves, and fillets; which is the case in our analysis. Using ANSYS Workbench for the base model we see the same trend in Stress concentration as we see in the principal and Von Mises stress distribution of the lever guide.

Therefore, when selecting the profile of the stress relief groove, we have to make sure the overhang length due to the chamfer length is equal or less than the chamfer length as a high overhang length can result in compressive stress on the inner surface of the lever guide. Carefully observing our outcomes for various radii and chamfer length we conclude that a stress relief groove with a radius of 3.5 mm and 4mm with a chamfer length of 4mm will produce the best result but we also have to look at the overall manufacturing limitation of the HPP vessel.
3.2.3 Von Mises stress and maximum principal stress distribution (APDL)

The 2-dimensional study was also carried out using ANSYS APDL. The goal was to find the combination of radii length and chamfer length which decrease the maximum Von Mises stress. The results from the test were created using ANSYS APDL shown below in Table 2.

Table 2: Von Mises and max principle stress distribution

<table>
<thead>
<tr>
<th>Radius</th>
<th>Chamfer Length</th>
<th>Von Mises Stress (MPa)</th>
<th>Max Principal Stress(MPa)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Region A</td>
<td>Region B</td>
</tr>
<tr>
<td>NO SRG</td>
<td>1mm</td>
<td>1580</td>
<td>883</td>
</tr>
<tr>
<td></td>
<td>2mm</td>
<td>1640</td>
<td>912</td>
</tr>
<tr>
<td></td>
<td>3mm</td>
<td>1100</td>
<td>697</td>
</tr>
<tr>
<td></td>
<td>4mm</td>
<td>1500</td>
<td>1000</td>
</tr>
<tr>
<td></td>
<td>.5mm</td>
<td>1250</td>
<td>972</td>
</tr>
<tr>
<td></td>
<td>1mm</td>
<td>1130</td>
<td>883</td>
</tr>
<tr>
<td></td>
<td>1.5mm</td>
<td>2950</td>
<td>988</td>
</tr>
<tr>
<td></td>
<td>2mm</td>
<td>1330</td>
<td>912</td>
</tr>
<tr>
<td></td>
<td>2.5mm</td>
<td>1310</td>
<td>876</td>
</tr>
<tr>
<td></td>
<td>3mm</td>
<td>1140</td>
<td>697</td>
</tr>
<tr>
<td></td>
<td>3.5mm</td>
<td>1660</td>
<td>922</td>
</tr>
<tr>
<td></td>
<td>4mm</td>
<td>1250</td>
<td>1000</td>
</tr>
<tr>
<td></td>
<td>.5mm</td>
<td>2430</td>
<td>546</td>
</tr>
<tr>
<td>1mm</td>
<td>1mm</td>
<td>1080</td>
<td>722</td>
</tr>
<tr>
<td></td>
<td>1.5mm</td>
<td>956</td>
<td>650</td>
</tr>
<tr>
<td></td>
<td>2mm</td>
<td>1810</td>
<td>607</td>
</tr>
<tr>
<td></td>
<td>2.5mm</td>
<td>981</td>
<td>657</td>
</tr>
<tr>
<td></td>
<td>3mm</td>
<td>1010</td>
<td>675</td>
</tr>
<tr>
<td></td>
<td>3.5mm</td>
<td>2280</td>
<td>512</td>
</tr>
<tr>
<td></td>
<td>4mm</td>
<td>1090</td>
<td>731</td>
</tr>
<tr>
<td></td>
<td>.5mm</td>
<td>931</td>
<td>623</td>
</tr>
<tr>
<td>2mm</td>
<td>1mm</td>
<td>1660</td>
<td>560</td>
</tr>
<tr>
<td></td>
<td>1.5mm</td>
<td>752</td>
<td>586</td>
</tr>
<tr>
<td></td>
<td>2mm</td>
<td>1170</td>
<td>525</td>
</tr>
<tr>
<td></td>
<td>2.5mm</td>
<td>811</td>
<td>543</td>
</tr>
<tr>
<td></td>
<td>3mm</td>
<td>2060</td>
<td>465</td>
</tr>
<tr>
<td></td>
<td>3.5mm</td>
<td>875</td>
<td>586</td>
</tr>
<tr>
<td></td>
<td>4mm</td>
<td>1390</td>
<td>621</td>
</tr>
</tbody>
</table>
The results have unusual pattern to them. As the radius of the stress relieve groove goes up, the Von Mises stresses generally decrease. An exception to this is when a radius of 3mm is tested, and then the stress goes up for chamfer lengths of 1mm and 3mm. This seems to be due to the large amount of deformation of the lever guide as the lever contacts the right corner of the stress relieve groove. There doesn’t seem to be a strong correlation between the chamfer length and the maximum stress at either point A or B. This is because the amount of overhang length between the right edge of the stress relief groove and the lever differs with each radii and chamfer length value. If the chamfer length is small, the lever can actually deform in such a way that the top outside edges deform into the curve of the stress relieve groove. Understanding the behavior of the deformation of the lever is extremely important when creating a stress relief groove. Contour plots of the Von Mises stresses are presented below in Figure 21 through 24 to show the behavior of stress concentration for varying radii and chamfer length parameters.
Figure 21: No stress relief groove, chamfer length = 4mm

As seen above in Figure 21, the maximum Von Mises Stress (1500 MPa) is at the point where the lever contacts the lever guide. This is base model with no stress relief groove, used as a reference for comparison.
As seen above in Figure 22, the maximum Von Mises Stress (1250 MPa) is to the right of where the lever contacts the lever guide on the left side. This model has a stress relief groove with a radius of 1mm and the lever guide has a chamfer length of 4mm. The maximum Von Mises Stress is reduced by about 16.7% by incorporating the stress relief groove as compared to the base model.
As seen above in Figure 23, the maximum Von Mises Stress (1090 MPa) is at the point where the lever contacts the stress relieve groove on the lever guide. The stress relief groove has a radius of 2mm and the lever has a chamfer length of 4mm. The maximum Von Mises Stress is reduced by about 27.3% by incorporating this stress relief groove as compared to the base model.
As seen above in Figure 24, the maximum Von Mises stress (1390 MPa) is at the corner of the lever guide where the lever deforms. This model has a stress relief groove with a radius of 1mm and the lever guide has a chamfer length of 4mm. The maximum Von Mises stress is reduced by only 7.3 % by incorporating the stress relief groove as compared to the base model. This is least effective stress groove, due to the deformation of the lever around the lever guide.
3.3 Discussion

3.3.1 Challenges and limitations

In tackling these problems, certain challenges became evident. ANSYS has a steep learning curve, and these early analyses were necessary for the group members to familiarize themselves with the software. This was especially true for the work done in ANSYS Workbench, as none of the group members had used it previously. However, even with the initial setbacks and dead ends, these analyses were completed, and in the process, the group members developed the skills necessary for the analysis on the HPP part, as well as confidence in their abilities to find accurate results.

One limitation encountered in the project was the issue of manufacturability. Because none of the geometries analyzed were especially complex or much different from the original model, the group assumed they would be manufacturable. However, this is an assumption based on common sense, not in-depth research. It may indeed be true that the proposed geometries may be infeasible or impractical to manufacture, but that question is in the domain of an industry engineer, and not within the scope of this project.

Another limitation was the quantity of results. Given an arbitrarily large amount of time to complete the project, a much more thorough analysis would have been possible, however in reality this was not so. The two parameters to be tested (chamfer length and stress relief groove radius) were measured in intervals of 1mm, from 1mm to 4mm. This means there were 16 models tested in total (4 chamfer lengths times 4 SRG radii). If they were to be measured in intervals of 0.5mm, this would result in 64 models that must be analyzed. This exponential increase in the amount of analyses that must be conducted means that, due to time constraints, it
would be impractical to do an extremely thorough analysis of this problem, though the relevant trends are displayed in the next few sections to a reasonable degree of refinement.

3.3.2 Effects of the mesh

Mesh generation is the process of dividing the analysis continuum into a number of discrete parts, or finite elements. The simple straight-sided triangular mesh approximates an area very closely, but at the same time it introduces geometric errors along the boundary such as replacing a boundary curve with a series of straight lines. This geometric boundary error can be reduced to any desired level by increasing the number of finite elements, also known as refining the mesh. This increases the number of calculations but provides better geometric accuracy, and resolution of the result. When observing a model with any form of discontinuity, it is important to refine the mesh so that the change in the result from element to element is smooth.

Figure 25 and 26 show the difference between a rough mesh and a smooth mesh, and Figure 27 and 28 show the Von Mises stress generated from the rough and smooth meshes, respectively.
Figure 25: Example of a rough mesh

Figure 26: Example of a smooth mesh
Figure 27: Von Mises stress generated from rough mesh

Figure 28: Von Mises stress generated from smooth mesh
Both of these models are the base model of the HPP vessel with no stress relieve groove in ANSYS Workbench. The only difference between the models seen in Figure 27 and Figure 28 is the level of the refinement of the mesh. By comparing the contour plot in each of the figures, the influence of the refinement of the mesh can easily be seen. In the second model, the level of refinement was high around the inside of the lever guide. Because of this, the contour plot revealed a smooth change around the area of maximum stress instead of the jagged edges seen in the plot generated from the rough mesh.
4. Conclusion

High Pressure Processing offers an alternative way to prepare food for consumers without requiring heat. The pressure vessel used currently experiences a high stress concentration as a result of the large amount of pressure used to prepare the food. Multiple stress relief grooves were designed to observe the decrease in stress concentration for varying radius and chamfer length parameters. A finite element analysis was completed with both ANSYS APDL and Workbench to find the maximum Von Mises stress for each stress relief groove geometry. The results concluded that the stress increased when the lever was overhanging the lever guide by more than 4mm. This caused a large stress concentration at the point where the lever contacted the lever guide. Although the results from ANSYS Workbench and APDL varied, the combination of parameters which decreased the Von Mises Stress the most was when the radius was equal to 4mm and the chamfer length was 4mm. This reduces the maximum Von Mises stress by about 57%. By observing the behavior of the stress concentration for different geometries, it provides insight as to where this stress concentration comes from, and how it can be prevented.

We believe that the high spikes in the Von Mises stress in the critical regions are a result of the geometry of the part. That is, at these spikes, the lever deforms in the corners and actually deforms into the stress relief groove, resulting in a very high stress concentration. This is why it is important to analyze the Von Mises stress, and not just the maximum principal stress. If we had only looked at the maximum principal stress, we could conclude that the stresses decrease as the chamfer length and radius increase, in an almost linear fashion. However, looking at the Von Mises stress provides a different perspective: The geometry of the part may lead to unforeseen stress concentrations in certain critical regions, which can result in premature failure of the part.
For this reason, it is important to carry out this computational analysis of the Von Mises stress; merely calculating the maximum principal stress is insufficient.
Appendices

Appendix 1: APDL codes

(This is the ADPL code to generate the result from our base model. If you wish to copy our result, you must replace DIRECTORY with the location of an IGES file of the base model. The base model is included as Appendix 2.)

/BATCH
!/COM, ANSYS RELEASE 14.0 UP20111024 18:33:43 04/02/2013
/input, start140, ans, 'DIRECTORY', ............, 1
!*
/NOPR
KEYW, PR_SET, 1
KEYW, PR_STRUC, 1
KEYW, PR_THERM, 0
KEYW, PR_FLUID, 0
KEYW, PR_ELMAG, 0
KEYW, MAGNOD, 0
KEYW, MAGEDG, 0
KEYW, MAGHFE, 0
KEYW, MAGELC, 0
KEYW, PR_MULTI, 0
KEYW, PR_CFD, 0
/GO
!*
!/COM,
!/COM, Preferences for GUI filtering have been set to display:
!/COM, Structural
!*
/AUX15
!*
IOPTN, IGES, SMOOTH
IOPTN, MERGE, YES
IOPTN, SOLID, YES
IOPTN, SMALL, YES
IOPTN, GTOLER, DEFA
IGESIN, 'NO SRG 4mm', 'IGS', 'Solidworks\SCF MQP'
! LPLOT
!*
!*
/NOPR
KEYW, PR_SET, 1
KEYW, PR_STRUC, 1
KEYW, PR_THERM, 0
KEYW,PR_FLUID,0
KEYW,PR_ELMAG,0
KEYW,MAGNOD,0
KEYW,MAGEDG,0
KEYW,MAGHFE,0
KEYW,MAGELC,0
KEYW,PR_MULTI,0
KEYW,PR_CFD,0
/GO
!*
!/COM,
!/COM, Preferences for GUI filtering have been set to display:
!/COM, Structural
!*
FINISH
/PREP7
! /VIEW,1,,1
! /ANG,1
! /REP,FAST
FLST,2,10,4
FITEM,2,3
FITEM,2,4
FITEM,2,12
FITEM,2,13
FITEM,2,2
FITEM,2,9
FITEM,2,17
FITEM,2,7
FITEM,2,8
FITEM,2,18
AL,P51X
FLST,2,8,4
FITEM,2,15
FITEM,2,14
FITEM,2,11
FITEM,2,16
FITEM,2,5
FITEM,2,1
FITEM,2,6
FITEM,2,10
AL,P51X
!* 
ET,1,Plane 183
!* 
KEYOPT,1,1,1
KEYOPT,1,3,0
KEYOPT, 1, 6, 0
!* 
!* MPTEMP, , , , ,
   MPTEMP, 1, 0
MPDATA, EX, 1, 1, 205E9
MPDATA, PRXY, 1, 1, 3
MPTEMP, , , , ,
   MPTEMP, 1, 0
MPDATA, DENS, 1, 1, 7800
MPTEMP, , , , ,
   MPTEMP, 1, 0
MPDE, EX, 1
MPDE, PRXY, 1
MPDATA, EX, 1, 1, 2.05E+011
MPDATA, PRXY, 1, 1, 0.3
/U1, MESH, OFF
CM, _Y, AREA
ASEL, , , , , 1
CM, _Y1, AREA
CHKMSH, 'AREA'
CMSEL, S, _Y
!* MSHKEY, 2
AMESH, _Y1
MSHKEY, 0
!* CMDELE, _Y
   CMDELE, _Y1
   CMDELE, _Y2
!* CM, _Y, AREA
ASEL, , , , , 2
CM, _Y1, AREA
CHKMSH, 'AREA'
CMSEL, S, _Y
!* MSHKEY, 2
AMESH, _Y1
MSHKEY, 0
!* CMDELE, _Y
   CMDELE, _Y1
   CMDELE, _Y2
!* MSHKEY, 0
CM_Y,AREA
ASEL,,2
CM_Y1,AREA
CHKMSH,'AREA'
CMSEL,S,_Y
!*
!*
ACLEAR,_Y1
AMESH,_Y1
!*
CMDELE,_Y
CMDELE,_Y1
CMDELE,_Y2
!* 
FLST,5,37,2,ORDE,24
FITEM,5,2
FITEM,5,15
FITEM,5,-16
FITEM,5,29
FITEM,5,-30
FITEM,5,33
FITEM,5,-35
FITEM,5,39
FITEM,5,49
FITEM,5,-50
FITEM,5,52
FITEM,5,-54
FITEM,5,61
FITEM,5,-63
FITEM,5,69
FITEM,5,75
FITEM,5,-76
FITEM,5,78
FITEM,5,81
FITEM,5,-88
FITEM,5,97
FITEM,5,-98
FITEM,5,100
FITEM,5,-105
CM_Y,ELEM
ESEL,,P51X
CM_Y1,ELEM
CMSEL,S,_Y
CMDELE,_Y
!* 
!*
FITEM,5,-44
FITEM,5,47
FITEM,5,56
FITEM,5,-60
FITEM,5,72
FITEM,5,-74
FITEM,5,662
FITEM,5,-665
FITEM,5,694
FITEM,5,803
FITEM,5,981
FITEM,5,1013
FITEM,5,1029
CM,_Y,ELEM
ESEL, , , ,P51X
CM,_Y1,ELEM
CMSEL,S,_Y
CMDELE,_Y
!*
!* EREF,_Y1, , ,1,0,1,1
!* CMDELE:_Y1
!* FINISH
/SOL
FLST,2,1,4,ORDE,1
FITEM,2,3
!* /GO
DL,P51X, ,UX,0
FLST,2,2,4,ORDE,2
FITEM,2,2
FITEM,2,13
!* /GO
DL,P51X, ,UY,0
FLST,2,1,4,ORDE,1
FITEM,2,1
/GO
!* SFL,P51X,PRES,200E6,
FINISH
/PREP7
CM,_TARGET,LINE
!*
!*
! /COM, CONTACT PAIR CREATION - START
CM._NODECM,NODE
CM._ELEMCM,ELEM
CM._KPCM,KP
CM._LINECM,LINE
CM._AREACM,AREA
CM._VOLUCM,VOLU
!/GSAV,cwz,gsav,,temp
MP,MU,1,.2
MAT,1
R,3
REAL,3
ET,2,169
ET,3,172
KEYOPT,3,9,0
KEYOPT,3,10,2
R,3,
RMORE,
RMORE,0
RMORE,0
! Generate the target surface
LSEL,S,,2
LSEL,A,,3
LSEL,A,,4
LSEL,A,,7
LSEL,A,,8
LSEL,A,,9
LSEL,A,,12
LSEL,A,,13
LSEL,A,,17
LSEL,A,,18
CM._TARGET,LINE
TYPE,2
NSLL,S,1
ESLN,S,0
ESURF
CMSEL,S,_ELEMCM
! Generate the contact surface
LSEL,S,,6
LSEL,A,,11
LSEL,A,,15
CM._CONTACT,LINE
TYPE,3
NSLL,S,1
ESLN,S,0
ESURF
ALLSEL
ESEL,ALL
ESEL,S,TYPE,,2
ESEL,A,TYPE,,3
ESEL,R,REAL,,3
!/PSYMB,ESYS,1
!/PNUM,TYPE,1
!/NUM,1
!/PLOT
ESEL,ALL
ESEL,S,TYPE,,2
ESEL,A,TYPE,,3
ESEL,R,REAL,,3
CMSEL,A,_NODECM
CMDEL,_NODECM
CMSEL,A,_ELEMCM
CMDEL,_ELEMCM
CMSEL,S,_KPCM
CMDEL,_KPCM
CMSEL,S,_LINECM
CMDEL,_LINECM
CMSEL,S,_AREACM
CMSEL,S,_AREACM
CMDEL,_VOLUM
CMSEL,S,_VOLUM
CMDEL,_VOLUM
!/GRES,cwz,gsav
CMDEL,_TARGET
CMSEL,_CONTACT
!/COM, CONTACT PAIR CREATION - END
!/MREP,EPL
FINISH
/SOL
!*:
/STATUS,0
!/STATUS,SOLU
SOLVE
FINISH
/POST1
!*:
!/EFACET,1
! PLNSOL, S,EQV, 0,1.0
!/DIST,1,0.924021086472,1
!/REP,FAST
!/DIST,1,0.924021086472,1
!/REP,FAST
!/DIST,1,0.924021086472,1
/*
! /REP,FAST
! /DIST,1,1.08222638492,1
! /REP,FAST
! /DIST,1,1.08222638492,1
! /REP,FAST
! /DIST,1,1.08222638492,1
! /REP,FAST
! /DIST,1,1.08222638492,1
! /REP,FAST
! /DIST,1,1.08222638492,1
! /REP,FAST
! /DIST,1,1.08222638492,1
! /REP,FAST
! /DIST,1,1.08222638492,1
! /REP,FAST
! /DIST,1,1.08222638492,1
! /REP,FAST
! /DIST,1,0.924021086472,1
! /REP,FAST
! /DIST,1,0.924021086472,1
! /REP,FAST
! /DIST,1,1.08222638492,1
! /REP,FAST
! /DIST,1,1.08222638492,1
! /REP,FAST
! /DIST,1,1.08222638492,1
! /REP,FAST
! /DIST,1,1.08222638492,1
! /REP,FAST
! /DIST,1,1.08222638492,1
! /REP,FAST
! /SAVE, SCF_NO_SRG_4mm,db,
! /SAVE, SCF_NO_SRG_4mm,db,
! /SAVE, SCF_NO_SRG_4mm,db,
! /COM, ANSYS RELEASE 14.0  UP20111024  17:28:34  04/23/2013
/POST1
!*
! /EFACET,1
! /PLNSOL, S,EQV, 0,1.0
! /OUTPUT,'code',",'C:\Users\Jacob90\Desktop\MQP\,
! /LGWRITE,'code','lgw','C:\Users\Jacob90\Desktop\MQP\,COMMENT
Appendix 2: IGES code for base model

(This is the code for an IGES file of our base model. To use it, copy this code and then paste it into a program such as Microsoft Notepad. Then, “save as” and name the file as an IGES file, for example, “basemodel.igs”. Now, you can import the IGES file into ANSYS APDL.)

SolidWorks IGES file using NURBS representation for surfaces

1\H,1\H;,22\HFull Lever Guid.SLDPRT,62HC:\Users\Jacob90\Desktop\MQP\SolidwG\ork\SCF MQP\NO SRG 4mm.IGS,15HSolidWorks 2012,15HSolidWorks 2012,32, G 2
308,15,308,15,22\HFull Lever Guid.SLDPRT,1.,6,1HM,50,0.125,13H130329.1146G 3
53,1E-008,499.99,7HJacob90,,11,0,13H130329.114653; G 4

124 1 0 0 0 00000000D 1
124 0 0 1 0 0D 2
110 2 0 0 0 1 00020000D 3
110 0 0 1 0 0D 4
110 3 0 0 0 1 00020000D 5
110 0 0 1 0 0D 6
110 4 0 0 0 1 00020000D 7
110 0 0 1 0 0D 8
110 5 0 0 0 1 00020000D 9
110 0 0 1 0 0D 10
110 6 0 0 0 1 00020000D 11
110 0 0 1 0 0D 12
110 7 0 0 0 1 00020000D 13
110 0 0 1 0 0D 14
110 8 0 0 0 1 00020000D 15
110 0 0 1 0 0D 16
110 9 0 0 0 1 00020000D 17
110 0 0 1 0 0D 18
110 10 0 0 0 1 00020000D 19
110 0 0 1 0 0D 20
110 11 0 0 0 1 00020000D 21
110 0 0 1 0 0D 22
110 12 0 0 0 1 00020000D 23
110 0 0 1 0 0D 24
110 13 0 0 0 1 00020000D 25
110 0 0 1 0 0D 26
110 14 0 0 0 1 00020000D 27
110 0 0 1 0 0D 28
110 15 0 0 0 1 00020000D 29
110 0 0 1 0 0D 30
110 16 0 0 0 1 00020000D 31
110 0 0 1 0 0D 32
110 17 0 0 0 1 00020000D 33
110 0 0 1 0 0D 34
100 18 0 0 0 1 00020000D 35
100 0 0 1 0 0D 36
100 19 0 0 0 1 00020000D 37
100 0 0 1 0 0D 38
402 20 0 0 0 00000000D 39
402 0 0 1 16 2DSKETCH 1D 40
| 124,1.0,0.,0.,0.,0.1.0,0.,0.,0.1.0; | 1P 1 |
| 110,0.039,0.0,0.076,0.0; | 3P 2 |
| 110,0.0,0.0,0.035,0.0; | 5P 3 |
| 110,0.0,0.0,0.0.103,0; | 7P 4 |
| 110,0.104,0.103,0.,0.,0.103,0; | 9P 5 |
| 110,0.076,0.0,0.08,0.004,0; | 11P 6 |
| 110,0.08,0.004,0.,0.08,0.036,0; | 13P 7 |
| 110,0.035,0.0,0.035,0.039,0; | 15P 8 |
| 110,0.079,0.04,0.0,0.036,0.04,0; | 17P 9 |
| 110,0.08,0.0,0.08,0.039,0; | 19P 10 |
| 110,0.08,0.036,0.0,0.076,0.04,0; | 21P 11 |
| 110,0.039,0.04,0.0,0.076,0.04,0; | 23P 12 |
| 110,0.104,0.0,0.104,0.103,0; | 25P 13 |
| 110,0.104,0.0,0.08,0.0,0; | 27P 14 |
| 110,0.039,0.04,0.,0.035,0.036,0; | 29P 15 |
| 110,0.035,0.036,0.,0.035,0.004,0; | 31P 16 |
| 110,0.035,0.004,0.,0.039,0.,0; | 33P 17 |
| 100,0.,0.079,0.039,0.08,0.039,0.079,0.04; | 35P 18 |
| 100,0.,0.036,0.039,0.036,0.04,0.035,0.039; | 37P 19 |
| 402,1,18,1.3,5,7,9,11,13,15,17,19,21,23,25,27,29,31,33,35,37; | 39P 20 |

S 1G 4D 40P 20 T 1
Appendix 3: Workbench procedure

In this section, computational procedural data from ANSYS Workbench is shown. This data and values are for the base model with the fillet. The section starts off with the geometry of the model, and then goes onto explain the analysis settings, mesh size, connections, loads, and material data that were used for the purpose of our analysis. A step-by-step instruction to replicate and verify our results using ANSYS Workbench software is provided below:

1) We started off by opening up the ANSYS Workbench software. This can be done from the start menu by clicking on Start Menu > ANSYS 14.0 > Workbench 14.0.

2) Then we defined the type of Analysis we’ll be performing. In this case it is a Static Structural Analysis. So we click and drag “Static Structural” from the ANSYS Workbench toolbox that is on the left hand side of the screen to Project Schematic section of the screen and drop it inside the highlighted rectangle.
3) Then we continue working through the system from top to bottom. We start off by verifying “Engineering Data”. If we double click on 2. Engineering Data from Static Structural materials selection window opens up and we can select our desired material from there. By clicking on Return to Project we can go back to the Project Schematic window.

4) Then we can start building our model. Before we build our model we have to make sure we’re performing a 2D analysis. If we single click on the “Geometry” section on the Project Schematic window, on the right hand side we will see “Properties of Schematics:
Geometry”. If we scroll down we can see Analysis type. By clicking on it we can select 2D analysis.

5) Then we can start creating our model by double clicking on the Geometry window. As we open up the geometry window a unit selection window will open up. Here we have to select our appropriate unit for our model. Then we start working on our model. We modeled ours in the XY plane and we had two different sketches for the lever and lever guide. With the appropriate dimensions two sketches were made. The sketches are highlighted in blue.
6) Then we gradually generated two surfaces by clicking Concept > Surfaces From Sketches from the top of the menu selection and by selecting each sketches. Then by clicking generate from the menu we can generate the surfaces that we want.
7) Then in order to make the two surfaces share the same topology we formed a new part. This can be done by selecting the surfaces and clicking Tools > Form New Part.

8) After that we closed the design modeler and opened up ANSYS Mechanical by double clicking on the Model that is on Project Schematic.

9) In ANSYS Mechanical we first defined the connections by clicking on Connections > Contacts and we defined the connections as Bonded surface.
10) Then we generated Mesh. This can be done by clicking Mesh > Insert > Face Sizing. By holding ctrl and clicking on the geometries two different geometries were selected.
11) Then we refined the contact areas as well the critical regions A and B. This can be done by clicking Mesh > Insert > Refinement. Two refined regions are shown below.

12) Then Mesh for the system can be generated by right clicking Mesh > Generate Mesh.
13) Finally we want to define the boundaries for the project. We defined the boundaries by right clicking on Static Structural that is right beneath Mesh in ANSYS Mechanical. If we right click on Static Structural > Insert we can see the curious loads that can be applied to the problem. For our problem we selected Pressure and Frictionless Support.

The processes of applying loads are shown below.

14) Then we click on Solution and select the type of solution we want to generate. Since we are focusing on Maximum Principal and Von Mises Stress we selected those two by clicking on Stress > Max Principal Stress.
15) Finally by clicking Solve which is located at the top of the menu the problem can be solved.
Modified version of the Report Generated by ANSYS Workbench

Units

<table>
<thead>
<tr>
<th>Table 1</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unit System</strong></td>
</tr>
<tr>
<td>Angle</td>
</tr>
<tr>
<td>Rotational Velocity</td>
</tr>
<tr>
<td>Temperature</td>
</tr>
</tbody>
</table>

Model (A4)

Geometry

<table>
<thead>
<tr>
<th>Table 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Object Name</strong></td>
</tr>
<tr>
<td><strong>State</strong></td>
</tr>
<tr>
<td><strong>Definition</strong></td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Length Unit</td>
</tr>
<tr>
<td>Element Control</td>
</tr>
<tr>
<td>2D Behavior</td>
</tr>
<tr>
<td>Display Style</td>
</tr>
<tr>
<td><strong>Bounding Box</strong></td>
</tr>
<tr>
<td>Length X</td>
</tr>
<tr>
<td>Length Y</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
</tr>
<tr>
<td>Volume</td>
</tr>
<tr>
<td>Mass</td>
</tr>
<tr>
<td>Surface Area(approx.)</td>
</tr>
<tr>
<td>Scale Factor Value</td>
</tr>
<tr>
<td><strong>Statistics</strong></td>
</tr>
<tr>
<td>Bodies</td>
</tr>
<tr>
<td>Active Bodies</td>
</tr>
<tr>
<td>Nodes</td>
</tr>
<tr>
<td>Elements</td>
</tr>
<tr>
<td>Mesh Metric</td>
</tr>
</tbody>
</table>
**TABLE 3**  
Model (A4) > Geometry > Body Groups

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Part</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Meshed</td>
</tr>
</tbody>
</table>

**Graphics Properties**

| Visible | Yes |

**Definition**

| Suppressed | No |
| Assignment | Structural Steel |
| Coordinate System | Default Coordinate System |

**Bounding Box**

| Length X | 104. mm |
| Length Y | 103. mm |

**Properties**

| Volume | 1068. mm³ |
| Mass   | 8.3841e-003 kg |
| Centroid X | 51.984 mm |
| Centroid Y | 51.594 mm |
| Centroid Z | 0. mm |
| Moment of Inertia Ip1 | 7.4003 kg·mm² |
| Moment of Inertia Ip2 | 7.5675 kg·mm² |
| Moment of Inertia Ip3 | 14.968 kg·mm² |
| Surface Area(approx.) | 10680 mm² |

**Statistics**

| Nodes | 15053 |
| Elements | 4829 |
| Mesh Metric | None |
**TABLE 4**  
Model (A4) > Geometry > Part > Parts

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Surface Body</th>
<th>Surface Body</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Meshed</td>
<td></td>
</tr>
</tbody>
</table>

**Graphics Properties**

<table>
<thead>
<tr>
<th>Visible</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transparency</td>
<td>1</td>
</tr>
</tbody>
</table>

**Definition**

<table>
<thead>
<tr>
<th>Suppressed</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stiffness Behavior</td>
<td>Flexible</td>
</tr>
<tr>
<td>Coordinate System</td>
<td>Default Coordinate System</td>
</tr>
<tr>
<td>Reference Temperature</td>
<td>By Environment</td>
</tr>
<tr>
<td>Thickness</td>
<td>0.1 mm</td>
</tr>
<tr>
<td>Thickness Mode</td>
<td>Refresh on Update</td>
</tr>
</tbody>
</table>

**Material**

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Structural Steel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nonlinear Effects</td>
<td>Yes</td>
</tr>
<tr>
<td>Thermal Strain Effects</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Bounding Box**

<table>
<thead>
<tr>
<th>Length X</th>
<th>104. mm</th>
<th>45. mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length Y</td>
<td>103. mm</td>
<td>40. mm</td>
</tr>
</tbody>
</table>

**Properties**

<table>
<thead>
<tr>
<th>Volume</th>
<th>891.24 mm³</th>
<th>176.8 mm³</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass</td>
<td>6.9963e-003 kg</td>
<td>1.3879e-003 kg</td>
</tr>
<tr>
<td>Centroid X</td>
<td>50.889 mm</td>
<td>57.5 mm</td>
</tr>
<tr>
<td>Centroid Y</td>
<td>57.861 mm</td>
<td>20. mm</td>
</tr>
<tr>
<td>Centroid Z</td>
<td>0. mm</td>
<td></td>
</tr>
<tr>
<td>Moment of Inertia Ip1</td>
<td>5.512 kg·mm²</td>
<td>0.17962 kg·mm²</td>
</tr>
<tr>
<td>Moment of Inertia Ip2</td>
<td>7.3383 kg·mm²</td>
<td>0.22716 kg·mm²</td>
</tr>
<tr>
<td>Moment of Inertia Ip3</td>
<td>12.85 kg·mm²</td>
<td>0.40679 kg·mm²</td>
</tr>
<tr>
<td>Surface Area(approx.)</td>
<td>8912.4 mm²</td>
<td>1768. mm²</td>
</tr>
</tbody>
</table>

**Statistics**

<table>
<thead>
<tr>
<th>Nodes</th>
<th>11720</th>
<th>3333</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elements</td>
<td>3769</td>
<td>1060</td>
</tr>
<tr>
<td>Mesh Metric</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>
### TABLE 6
Model (A4) > Connections

<table>
<thead>
<tr>
<th>Object Name</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections</td>
<td>Fully Defined</td>
</tr>
</tbody>
</table>

#### Auto Detection
Generate Automatic Connection On Refresh: Yes

#### Transparency
Enabled: Yes

### TABLE 7
Model (A4) > Connections > Contacts

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contacts</td>
<td></td>
</tr>
</tbody>
</table>

#### State
Fully Defined

#### Definition
Connection Type: Contact

#### Scope
Scoping Method: Geometry Selection
Geometry: All Bodies

#### Auto Detection
Tolerance Type: Slider
Tolerance Slider: 0.
Tolerance Value: 0.36593 mm
Use Range: No
Face/Edge: No
Edge/Edge: Yes
Priority: Include All
Group By: Bodies
Search Across: Bodies
TABLE 8
Model (A4) > Connections > Contacts > Contact Regions

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Bonded - Surface Body To Surface Body</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Fully Defined</td>
</tr>
</tbody>
</table>

**Scope**

<table>
<thead>
<tr>
<th>Scoping Method</th>
<th>Geometry Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact</td>
<td>1 Edge</td>
</tr>
<tr>
<td>Target</td>
<td>1 Edge</td>
</tr>
<tr>
<td>Contact Bodies</td>
<td>Surface Body</td>
</tr>
<tr>
<td>Target Bodies</td>
<td>Surface Body</td>
</tr>
</tbody>
</table>

**Definition**

<table>
<thead>
<tr>
<th>Type</th>
<th>Bonded</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scope Mode</td>
<td>Manual</td>
</tr>
<tr>
<td>Behavior</td>
<td>Program Controlled</td>
</tr>
<tr>
<td>Suppressed</td>
<td>No</td>
</tr>
</tbody>
</table>

**Advanced**

<table>
<thead>
<tr>
<th>Formulation</th>
<th>Augmented Lagrange</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detection Method</td>
<td>Nodal-Normal To Target</td>
</tr>
<tr>
<td>Normal Stiffness</td>
<td>Program Controlled</td>
</tr>
<tr>
<td>Update Stiffness</td>
<td>Program Controlled</td>
</tr>
<tr>
<td>Pinball Region</td>
<td>Program Controlled</td>
</tr>
</tbody>
</table>

Mesh

TABLE 9
Model (A4) > Mesh

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Mesh</th>
</tr>
</thead>
</table>

**Statistics**

<table>
<thead>
<tr>
<th>Statistics</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Nodes</td>
<td>15053</td>
</tr>
<tr>
<td>Elements</td>
<td>4829</td>
</tr>
<tr>
<td>Mesh Metric</td>
<td>None</td>
</tr>
<tr>
<td>Object Name</td>
<td>Face Sizing</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>State</td>
<td>Fully Defined</td>
</tr>
</tbody>
</table>

**Scope**

<table>
<thead>
<tr>
<th>Scoping Method</th>
<th>Geometry Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geometry</td>
<td>2 Faces</td>
</tr>
<tr>
<td></td>
<td>1 Edge</td>
</tr>
</tbody>
</table>

**Definition**

<table>
<thead>
<tr>
<th>Suppressed</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Element Size</td>
</tr>
<tr>
<td>Element Size</td>
<td>0.5 mm</td>
</tr>
<tr>
<td>Behavior</td>
<td>Soft</td>
</tr>
<tr>
<td>Curvature Normal Angle</td>
<td>Default</td>
</tr>
<tr>
<td>Growth Rate</td>
<td>Default</td>
</tr>
<tr>
<td>Refinement</td>
<td>3</td>
</tr>
</tbody>
</table>

**TABLE 10**

Model (A4) > Mesh > Mesh Controls
### Analysis Settings

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Analysis Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Fully Defined</td>
</tr>
</tbody>
</table>

#### Step Controls

| Number Of Steps       | 1.                |
| Current Step Number   | 1.                |
| Step End Time         | 1. s              |
| Auto Time Stepping    | Program Controlled|

#### Solver Controls

| Solver Type           | Program Controlled|
| Weak Springs          | Program Controlled|
| Large Deflection      | Off               |
| Inertia Relief        | Off               |

#### Restart Controls

| Generate Restart Points | Program Controlled|
| Retain Files After Full Solve | No                |

#### Nonlinear Controls

| Force Convergence     | Program Controlled|
| Moment Convergence    | Program Controlled|
| Displacement Convergence | Program Controlled|
| Rotation Convergence  | Program Controlled|
| Line Search           | Program Controlled|
| Stabilization         | Off               |

#### Output Controls

| Stress                | Yes               |
| Strain                | Yes               |
| Solver Unit System    | mm                |
# TABLE 13
Model (A4) > Static Structural (A5) > Loads

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Frictionless Support</th>
<th>Frictionless Support 2</th>
<th>Frictionless Support 3</th>
<th>Pressure</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Fully Defined</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Scope
- Scoping Method: Geometry Selection
- Geometry: 1 Edge

## Definition
<table>
<thead>
<tr>
<th>Type</th>
<th>Frictionless Support</th>
<th>Pressure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suppressed</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Define By</td>
<td>Components</td>
<td></td>
</tr>
<tr>
<td>Coordinate System</td>
<td>Global Coordinate System</td>
<td></td>
</tr>
<tr>
<td>X Component</td>
<td>0. MPa (ramped)</td>
<td></td>
</tr>
<tr>
<td>Y Component</td>
<td>2.e+008 MPa</td>
<td></td>
</tr>
</tbody>
</table>

**FIGURE 1**
Model (A4) > Static Structural (A5) > Pressure

Solution (A6)
Model (A4) > Static Structural (A5) > Solution (A6) > Solution Information

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Solution Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Solved</td>
</tr>
</tbody>
</table>

**Solution Information**

<table>
<thead>
<tr>
<th>Solution Output</th>
<th>Solver Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Newton-Raphson Residuals</td>
<td>0</td>
</tr>
<tr>
<td>Update Interval</td>
<td>2.5 s</td>
</tr>
<tr>
<td>Display Points</td>
<td>All</td>
</tr>
</tbody>
</table>

**FE Connection Visibility**

<table>
<thead>
<tr>
<th>Activate Visibility</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>All FE Connectors</td>
</tr>
<tr>
<td>Draws Connections Attached To</td>
<td>All Nodes</td>
</tr>
<tr>
<td>Line Color</td>
<td>Connection Type</td>
</tr>
<tr>
<td>Visible on Results</td>
<td>No</td>
</tr>
<tr>
<td>Line Thickness</td>
<td>Single</td>
</tr>
<tr>
<td>Display Type</td>
<td>Lines</td>
</tr>
</tbody>
</table>

**Material Data**

*Structural Steel*

**TABLE 17**

<table>
<thead>
<tr>
<th>Structural Steel &gt; Constants</th>
</tr>
</thead>
<tbody>
<tr>
<td>Density</td>
</tr>
<tr>
<td>Coefficient of Thermal Expansion</td>
</tr>
<tr>
<td>Specific Heat</td>
</tr>
<tr>
<td>Thermal Conductivity</td>
</tr>
<tr>
<td>Resistivity</td>
</tr>
</tbody>
</table>

**TABLE 18**

<table>
<thead>
<tr>
<th>Structural Steel &gt; Compressive Ultimate Strength</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compressive Ultimate Strength MPa</td>
</tr>
</tbody>
</table>

**TABLE 19**

<table>
<thead>
<tr>
<th>Structural Steel &gt; Compressive Yield Strength</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compressive Yield Strength MPa</td>
</tr>
</tbody>
</table>

**TABLE 20**

<table>
<thead>
<tr>
<th>Structural Steel &gt; Tensile Yield Strength</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tensile Yield Strength MPa</td>
</tr>
</tbody>
</table>
### Structural Steel > Strain-Life Parameters

<table>
<thead>
<tr>
<th>Strength Coefficient MPa</th>
<th>Strength Exponent</th>
<th>Ductility Coefficient</th>
<th>Ductility Exponent</th>
<th>Cyclic Strength Coefficient MPa</th>
<th>Cyclic Strain Hardening Exponent</th>
</tr>
</thead>
<tbody>
<tr>
<td>920</td>
<td>-0.106</td>
<td>0.213</td>
<td>-0.47</td>
<td>1000</td>
<td>0.2</td>
</tr>
</tbody>
</table>

### TABLE 25

### Structural Steel > Isotropic Elasticity

<table>
<thead>
<tr>
<th>Temperature °C</th>
<th>Young's Modulus MPa</th>
<th>Poisson's Ratio</th>
<th>Bulk Modulus MPa</th>
<th>Shear Modulus MPa</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.e+005</td>
<td>2.e+005</td>
<td>0.3</td>
<td>1.6667e+005</td>
<td>76923</td>
</tr>
</tbody>
</table>
Bibliography


